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1 Начало работы в программе DEFORM 
После запуска системы DEFORM-3D на экране появляется большое окно, 

которое называют главным окном. Интерфейс системы имеет стандартные 
элементы управления, характерные для программ, работающих в операцион-
ной системе Windows (рис. 1). 

 
Рис. 1. Главное окно системы 

Начнем моделирование процесса горячей штамповки детали типа «ша-
тун». В главном меню выбираем File → New problem или иконку  на пане-
ли инструментов – появляется окно выбора типа решаемой задачи (механиче-
ская обработка, свободная ковка, деформирование, общая задача и т.д.), в 
котором выбираем Forming wizard (Помощник деформирования) и нажимаем 
Next (рис. 2). 

Следующие 2 окна позволяют указать директорию для размещения соз-
даваемой задачи и ввести имя проблемы (здесь и далее разрешается исполь-
зовать только буквы английского алфавита), соглашаемся с установками по 
умолчанию – нажимаем Next, а затем Finish. Запускается препроцессорная 
часть программы DEFORM. 
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Рис. 2. Выбор типа задачи 

2 Препроцессор программы DEFORM 
Внешний вид препроцессора, запущенного в режиме помощника дефор-

мирования, несколько отличается от препроцессора обычного режима (рис. 
3). Он также имеет главное меню и панели инструментов (панель работы с 
файлами и панель управления изображением), но в правой части находится 
дерево построения, облегчающее создание модели расчета. 

2.1 Ввод начальных сведений о процессе 
Сразу после запуска препроцессора появляется окно выбора системы 

единиц, которая будет использоваться при расчете. Выбираем System Interna-
tional (Международная система измерений) и нажимаем Next (рис. 4). 

Следующее окно позволяет установить тип решаемой задачи, а именно: 
холодная, теплая или горячая деформация (рис. 5). Выбираем горячую де-
формацию – Hot Forming, нажимаем Next. 

Далее помощник деформирования предлагает выбрать вариант модели-
рования температурной стороны процесса: расчет изменения температуры 
штампов (в этом случае будет сгенерирована сетка конечных элементов 
штампов), расчет температурного поля только штампуемой детали или рас-
чет изотермического процесса (температура не рассчитывается). Моделиро-
вать измерение температурного поля будем только в заготовке, поэтому вы-
бираем Constant die temperature (Постоянная температура штампов) и нажи-
маем Next (рис. 6). 
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Рис. 3. Главное окно препроцессора 

  
Рис. 4. Выбор системы единиц Рис. 5. Выбор типа процесса 

На следующем шаге необходимо указать сложность моделируемой гео-
метрии (для более сложной геометрии необходимо большее число конечных 
элементов) и точность расчета (при одном и том же числе конечных элемен-
тов более высокая точность обеспечивает достоверные результаты, но увели-
чивает продолжительность расчета). Ползунок Shape complexity (Сложность 
геометрии) сдвигаем на Complex (Сложная), а Accuracy (Точность) оставляем 
на уровне Moderate (Умеренная). Нажимаем Next (рис. 7). 
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Рис. 6. Выбор типа расчета Рис. 7. Выбор точности расчета 

Следующее окно позволяет установить вид деформируемой заготовки: 
целая заготовка или только ее часть, обусловленная симметрией заготовки 
относительно какой-либо плоскости. В связи с тем, что моделируемая деталь 
обладает симметрией относительно плоскости XZ, то выбираем Symmetry 
(Симметрия) и нажимаем Next (рис. 8). 

  
Рис. 8. Учет симметричности детали Рис. 9. Выбор количества штампов 

На следующем этапе необходимо указать количество объектов, участ-
вующих в моделируемом процессе. Для данного случая это заготовка, верх-
няя и нижняя половина штампа, поэтому выбираем 1 workpiece + 2 dies (1 
заготовка + 2 штампа) и нажимаем Next. 

2.2 Ввод сведений о заготовке 
Далее начинается блок окон, позволяющих ввести данные о деформи-

руемой заготовке. В первом окне в графе Temperature вводим температуру 
заготовки – 1000ºС, нажимаем Next (рис. 10). Появляется окно загрузки гео-
метрии – оставляем Import from an existing file (Импортировать из сущест-
вующего файла) и нажимаем Next (рис. 11). Указываем путь к папке с сохра-
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ненной геометрией в формате STL, выбираем файл zagotovka и нажимаем 
Открыть (рис. 12). Загружается геометрия заготовки (рис. 13). 

  
Рис. 10. Ввод температуры заготовки Рис. 11. Импортирование геометрии 

 
Рис. 12. Открытие файла с геометрией 

В следующем окне производится ввод параметров, контролирующих ка-
чество генерируемой сетки конечных элементов. При этом число конечных 
элементов, выставленное по умолчанию, непосредственно определяется 
сложностью геометрии. Не будем изменять рекомендуемое число элементов 
– нажимаем Next (рис. 14). Построенная сетка конечных элементов изобра-
жена на рис. 13. 

Теперь необходимо ввести сведения о материале заготовки: выбрать ма-
териал из стандартной  библиотеки или создать новый. Выбираем Create new 
material (Создать новый  материал) и нажимаем Next (рис. 15).  Заполняем 
графу  Material Name  (Марка  материала)  – вводим  12ХН3А (английскими  
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Рис. 13. Геометрия и сетка конечных элементов заготовки 

  
Рис. 14. Задание количества элементов Рис. 15. Создание нового материала 

 

  
Рис. 16. Ввод марки стали Рис. 17. Пластические свойства 

буквами). Ставим галочку напротив Define elastic properties (Определить уп-
ругие свойства) и нажимаем Next (рис. 16). 

В следующем окне оставляем все без изменений (рис. 17) и нажимаем 

иконку  напротив Flow stress (Напряжение течения). Загружается окно 
(рис. 18), позволяющее задать сопротивление материала пластической де-
формации как функцию от степени деформации, скорости деформации и 
температуры процесса. 
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Рис. 18. Окно ввода пластических свойств материала 

В поля Strain, Strain Rate и Temperature введем соответственно степени 
деформации (безразмерная величина), скорости деформации (1/с) и темпера-
туры (ºС), приведенные на рис. 19. Всегда при вводе цифр в качестве знака, 
отделяющего целую часть числа от десятичной, необходимо использовать 
точку. Для добавления новой строки в поле необходимо нажать иконку 

, а для удаления – . 

 
Рис. 19. Ввод степени и скорости деформации и температуры 

Далее введем значения сопротивления деформации (МПа) при указанных 
параметрах. Для этого в поле Temperature выделяем нужную температуру 
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(подсвечивается черной рамкой), а затем в поле ввода данных о материале 
(рис. 18) заносим значения с рис. 20. Повторяем эти действия для каждой 
температуры, нажимаем ОК. 

 
Рис. 20. Значения сопротивления деформации 

В следующем окне (рис. 17) нажимаем Next. В новое окно вводим упру-
гие свойства материала: Young’s Modulus (модуль Юнга) – 206754 МПа; Pois-
son’s Ratio (коэффициент Пуассона) – 0,3; Thermal Expansion (коэффициент 
линейного расширения) – 1,2·10-5 1/ºС (рис. 21). Нажимаем Next. 

На следующем этапе необходимо ввести тепловые свойства материала. 
Установим способ задания Thermal conductivity (Теплопроводность) и Heat 
capacity (Теплоемкость) как функции от температуры – выберем f(Temp.) в 
соответствующих графах (рис. 22). В графу Emissivity (Степень черноты те-
ла) введем 0,7. Теперь занесем данные о теплопроводности материала – на-

жимаем иконку , стоящую напротив Thermal conductivity. Загружается 
окно, в таблицу которого вводим температуру (ºС) и теплопроводность 
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(Вт/(м·ºС)) с рис. 23. Нажимаем ОК. Действуя аналогично, вводим сведения о 
теплоемкости материала (кДж/(м3·ºС)) с рис. 24. Нажимаем Next. 

  
Рис. 21. Ввод упругих свойств Рис. 22. Ввод тепловых свойств 

 
Рис. 23. Теплопроводность материала 

Появляется окно, предлагающее выполнить сохранение созданного мате-
риала в библиотеке (рис. 25). Сохранять не будем – выбираем No. Нажимаем 
Next. 

2.3 Ввод сведений о штамповой оснастке 
Следующие окна позволяют ввести данные о геометрии, температуре и 

движении штампов. 
Первым появляется окно (подобное изображенному на рис. 10), позво-

ляющее, как и при задании  сведений о заготовке, ввести название объекта и 
его температуру. Соглашаемся  с установками по умолчанию – нажимаем 
Next. Далее импортируем геометрию верхней половины штампа – открываем 
файл shtamp-verx. 
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Рис. 24. Теплоемкость материала 

 
 

Рис. 25. Отказ от сохранения материала Рис. 26. Задание движения штампа 

В следующем окне задаем движение инструмента – нажимаем иконку 
 (рис. 26). Загружается окно контроля движения: переходим на 

закладку Press/Hammer (Пресс/Молот); выбираем Hammer; в соответствую-
щие графы вводим Energy (Энергия удара) – 25·106 мДж; Blow efficiency 
(КПД удара) – 0,87; Hammer mass (Масса падающих частей) – 1 тонна (рис. 
27). Нажимаем ОК. 

Далее переходим к вводу сведений о нижней половине штампа: темпера-
туру оставляем по умолчанию, импортируем файл shtamp-niz. Заготовка и 
штамповая оснастка на данном шаге изображены на рис. 28. 
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Рис. 27. Ввод данных о молоте 

 
Рис. 28. Заготовка и штамповая оснастка 

Теперь необходимо выполнить позиционирование верхней и нижней по-
ловин штампа относительно заготовки. В новом окне выбираем Yes для пе-
рехода к позиционированию (рис. 29). Загружается окно позиционирования: 
переходим на закладку Interference (Интерференция); устанавливаем направ-
ление Z; вводим в графу Interference – 0 мм (рис. 30). Нажимаем Apply – по-
является сообщение, в котором нажимаем ОК. Нижняя половина штампа 
смещается вниз вдоль оси Z на 13 мм. 

В окно позиционирования вносим изменения: в графе Positioning object 
(Объект позиционирования) выбираем Top die (Верхний штамп); устанавли-
ваем направление -Z (рис. 31). Нажимаем Apply – появляется сообщение, в 
котором нажимаем ОК. Верхняя половина штампа смещается вверх вдоль 
оси Z на 13 мм. Нажимаем ОК. 
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Рис. 29. Переход к позиционированию объектов 

 
Рис. 30. Позиционирование нижней половины штампа 

 
Рис. 31. Позиционирование верхней половины штампа 
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Штамповая оснастка и заготовка после позиционирования изображены на 
рис. 28. 

В связи с тем, что на первых шагах была задана симметричность заготов-
ки, появляется окно, предлагающее определить плоскость симметрии. Нажи-
маем Next. Щелкаем ЛКМ по плоскости XZ заготовки (рис. 32) и нажимаем 
Next. 

 
Рис. 32. Определение плоскости симметрии заготовки 

2.4 Ввод сведений о контакте 
Первое окно ввода сведений позволяет ввести точность генерации кон-

такта. Оставим значения, установленные по умолчанию – нажимаем Next. В 
следующем окне (рис. 33) введем Friction coefficient (Коэффициент трения): 
нажимаем на иконку  и выбираем Hot forging (lubricated) (Горячее дефор-
мирование со смазкой). Heat transfer coefficient (коэффициент теплопереда-
чи) оставляем без изменений, нажимаем Next. 

  
Рис. 33. Ввод коэффициента трения Рис. 34. Ввод перемещения штампа 

2.5 Задание числа шагов расчета 
В следующем окне (рис. 34) необходимо ввести Die stroke (Перемещение 

штампа), однако это значение удобнее замерить непосредственно с геомет-
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рии. В главном меню выбираем Display → Magnify или иконку  на панели 
инструментов для перехода в режим увеличения рамкой. Увеличив область, 
выделенную на рис. 35 черной рамкой, необходимо в главном меню выбрать 
Display → Select или иконку  на панели инструментов для отключения 
режима увеличения. Теперь ЛКМ нужно щелкнуть по крайнему нижнему 
углу верхней половины штампа (приблизительно), а затем по крайнему верх-
нему углу нижней половины штампа (рис. 35). Между точками появится 
стрелка с измеренным расстоянием – 26 мм, которое автоматически появи-
лось в графе Die stroke (рис. 34). Нажимаем Next. 

 
Рис. 35. Измерение расстояния между штампами 

Для того чтобы снова целиком отобразить геометрию, необходимо в 
главном меню выбрать Display → Iso view → XYZ или иконку  на панели 
инструментов. 

  
Рис. 36. Ввод критерия остановки расчета Рис. 37. Ввод числа шагов расчета 

Далее можно ввести информацию об остановке расчета по достижении 
определенного перемещения штампа, заданного усилия штамповки или неко-
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торого расстояния между объектами. Пусть расчет остановится по достиже-
нии штампом перемещения в 26 мм – установим галочку напротив Die stroke 
exc

гов происходит запись ре-
зультатов

eeds the value (рис. 36). Нажимаем Next. 
В следующем окне (рис. 37) установим: Number of steps (Число шагов) – 

оставим значение по умолчанию; Step increment (Шаг сохранения) – изменим 
на 2. Step increment определяет, через сколько ша

 расчета в базу данных. Нажимаем Next. 

2.6 Проверка и генерация базы данных 
На следующем этапе производится проверка базы данных: наличие 3-х 

 говорит о правильности введенных сведений (рис. 38). Нажимаем Next. 
Начинается генерация и запись базы данных, об успешном завершении чего 
также говорит наличие 2-х  (рис. 39). Нажимаем Finish, Yes (согласие на 
выход из постпроцессора), Yes (сохранение файлов помощника). 

  
Рис. 38. я базы данных Проверка базы данных Рис. 39. Генераци

2.7 Запуск и остановка расчета 
Для запуска расчета задачи в главном меню выбираем Simulation → Start 

или иконку  на панели инструментов (рис. 1). О начале расчета выдается 
сообщение The simulation has been submitted! (Расчет запущен!), нажимаем 
ОК

 меню выбираем 
Simulatio

. Информация о расчете выводится на закладке Message в главном окне. 
В случае необходимости остановки расчета в главном

n → Stop или иконку  на панели инструментов. 

2.8 Моделирование второго удара 
Расчет данного процесса остановился на 141 шаге (при заданных 200 ша-

гах) с выводом следующего сообщения на закладке Message: Hammer energy 
has been fully consumed (Энергия молота была полностью поглощена). Это 
означает, что энергии молота не хватило для деформации заготовки за один 
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удар (верхняя и нижняя половины штампов не сомкнулись), поэтому необхо-
димо рассчитать 2-й удар. 

В навигаторе задач выделяем папку FORMING (папка текущей задачи) и 
нажимаем на ссылку Forming в запуске препроцессора (рис. 1). В появив-
шемся окне (рис. 40) выбираем Open wizard with database file (Открыть по-
мощник из базы данных) и нажимаем Next. Далее предлагается выбрать шаг 
расчета, с которого будет загружена база данных, выберем последний шаг – 
нажимаем иконку  (рис. 41). 

Рис. 40. Открытие базы данных Рис. 41. Выбор шага расчета 

Затем указываем, что необходимо создать новую операцию – выбираем Cre-
ate a new operation (Создать новую операцию) и нажимаем Next (рис. 42). Далее 
предлагается выбрать тип вносимых изменений в базу данных: замена штампов, 
перепозиционирование объектов или индивидуальные настройки. Выбираем 
Custom setup (Индивидуальные настройки) и нажимаем Next (рис. 43). 

После загрузки препроцессора в режиме помощника закрываем окно вы-
бора типа процесса (рис. 5) – нажимаем Close. В дереве построения (рис. 3) 
нажимаем на элемент Movement (Движение). 

Появляется окно (рис. 26), в котором нажимаем иконку . В 
окне контроля движения вводим энергию удара – 25·106 мДж в графе Energy 
(рис. 27). Нажимаем ОК, затем Close. 

Сгенерируем базу данных, для этого в дереве построения (рис. 3) нажи-
маем на элемент Database Generation (Генерация базы данных). Появляется 
окно, предлагающее сохранить предшествующие шаги – выбираем Yes и на-
жимаем ОК. Записывается новая база данных, затем нажимаем Finish и выхо-
дим из препроцессора. 
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Рис. 42. Создание новой операции Рис. 43. Внесение изменений 

Запускаем задачу на расчет, после расчета снова выводится сообщение о 
полном поглощении энергии молота. Это связано с тем, что для данного про-
цесса штамповки полные смыкание верхней и нижней половин штампов про-
исходит только при 8-м ударе молота, т.е. необходимо еще 6 раз, по выше- 
приведенному алгоритму, создать новую операцию и запустить ее расчет. 

3 Постпроцессор программы DEFORM 
Просмотр результатов моделирования осуществляется в постпроцессорной 

части программы, для входа в которую нажимаем на ссылку DEFORM-3D Post 
в запуске постпроцессора (рис. 1). Внешний вид постпроцессора отличается от 
препроцессора наличием панели управления анимацией и панели вывода ре-
зультатов расчета, а также командами настройки интерфейса (рис. 44). 

Все нижеприведенные результаты расчета взяты после моделирования 1-
го удара молота, поэтому могут отличаться от результатов последующих 
ударов. 

3.1 Просмотр анимации 
Наиболее наглядным способом оценки результатов расчета является про-

смотр анимации. В связи с тем, что моделировалась штамповка только сим-
метричной половины детали, то для удобства просмотра результатов можно 
отобразить 2-ю половину. В главном меню выбираем Tools → Symmetry или 
иконку  на панели инструментов. Появляется окно определения симмет-
рии, ЛКМ щелкаем по плоскости симметрии заготовки – плоскости XZ (рис. 
32). Отображается 2-я половина заготовки, нажимаем Close. Для удаления 
симметричной  части  нажимаем  иконку   на панели инструментов, выби- 
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Рис. 44. Главное окно постпроцессора 

раем Delete в появившемся окне, ЛКМ щелкаем по удаляемой части и нажи-
маем Close. 

Для воспроизведения анимации вперед (назад) необходимо на панели 
управления анимацией (рис. 44) нажать иконку  ( ); для остановки вос-
произведения – ; для пошагового воспроизведения вперед (назад) –  
( ); для перемещения в начало (конец) расчета –  ( ). 

Заготовка и штамповая оснастка после 1-го удара молота изображены на 
рис. 45. 

3.2 Создание графиков усилия и скорости 
Наиболее важным технологическим параметром в горячей объемной 

штамповке является усилие процесса. DEFORM позволяет строить график 
изменения усилия деформирования от перемещения верхней половины 
штампа. 

В главном меню выбираем Tools → Graph (Load Stroke) или иконку  
на панели инструментов. В появившемся окне (рис. 46) убираем галочки на-
против Bottom Die и Workpiece, в качестве X-Axis (Ось абсцисс) выбираем 
Stroke (Перемещение), для Y-Axis (Ось ординат) устанавливаем Z Load (Уси-
лие по оси Z). Нажимаем ОК. 
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Рис. 45. Заготовка до и после деформирования 

 
Рис. 46. Создание графика нагрузки 
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Рис. 47. График усилия и скорости 

Также можно построить график изменения скорости движения верхней 
половины штампа. Выбираем иконку  на панели инструментов, в появив-
шемся окне (рис. 46) в качестве Y-Axis устанавливаем 

 Z). Нажимаем ОК. 
Z Speed (Скорость по 

оси

ний и температуры 

ce

Графики усилия и скорости изображены на рис. 47. 

3.3 Просмотр распределения напряже
Для удобства просмотра необходимо 

отобразить только заготовку – выделяем 
Workpie  в дереве объектов и нажимаем 
иконку  на панели управления отобра-
жением объектов (рис. 44). Перейд  на 
последний шаг расчет

 

ем
а – нажмем  на

панели инструментов. 
Теперь выведем на экран распределе-

ние интенсивности деформаций. В глав-
ном меню выбираем Tools → State Vari-
able или иконку 

 

 на панели инструмен-
тов. В появившемся окне (рис. 48) рас-
крываем список Strain (Деформации) и 
выбираем Effective (Интенсивность), так-
же устанавливаем Scaling (Масшта ) на
Local (В пределах шага). Нажимаем ОК. 

Действуя аналогично, можно про-
смотреть деформационные и температур-
ные переменные. Распределение интен-
сивности деформаций и напряжений, тем-
пературы и напр

б  

яжений по оси Z изобра-
жено на рис. 49. 

ния
од

 
 

3.4 Создание графика по пути 
DEFORM предоставляет возможность построения графиков любых пере-

менных по задаваемому пользователем маршруту. Создадим график измене-
 напряжения по оси Z (рис. 49) по телу заготовки. 
Сначала необх имо отобразить распределение напряжений по оси Z. 

Выбираем иконку  на панели инструментов. В появившемся окне (рис. 48) 

Р  
интенсивности деформаций 
ис. 48. Вывод распределения
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раскрываем список Stress (Напряжения) и выбираем Z/Z, также устанавлива-
ем Scaling (Масштаб) на Local (В пределах шага). Нажимаем ОК. 

 
Рис. 49. Отображение результатов моделирования 
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Рис. 50. Создание графика по пути 

В главном меню выбираем Tools → SV with Slicing или иконку  
закладку
к Sam-
началь

 ЛКМ
рис

на 
панели инструментов. В появившемся окне (рис. 50) переходим на  
Following Boundary (По границе), на которой передвигаем ползуно
pling Points (Исходные точки) на 1000. Теперь необходимо указать -
ную, промежуточную и конечную точки создаваемого пути, для этого  
щелкаем по деформированной заготовке в местах, показанных на . 50. 

Нажимаем иконку , затем Close. 
Полученный график распределения напряжения по оси Z изображен а 

рис. 51. 
н
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Рис. 51. График распределения напряжения по оси Z 
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